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Hardware 

Thermal Transient Anemometer Control Unit 
The Control Unit for the TTA is a standard 2U rack mount size with dimensions of 

17x13x3.5 inches (43.2x33.0x8.9 cm).  All connectors with the exception of the power 
are located on the front of the unit and can be seen in Figure 1. 

Power Connector 
The power connector is a custom high current connector with 32 pins for applying the 
heating voltage to any given cell and one or more ground leads returning.  The TTA ships 
with a custom 20 foot cable for the power delivery. 

Sense Connector 
The sense connector is a standard female micro DB50 SCSI II connector, as is the 
connector on the array end.  The TTA will be shipped with a 20 foot male to male SCSI 
II cable, but any male micro DB50 to male micro DB50 SCSI II cable can be used. 

External Voltmeter 
A standard female BNC connector provides the connection for reading a -10 to 10 volt 
analog voltage from an external device such as a pressure transducer. 

External Trigger 
The top female BNC connector is the external trigger input, and should not be confused 
with the external voltage connector. 

Serial Port 
The serial port on the TTA uses a PS2 connector and requires a custom DB9 to PS2 cable 
that will be shipped with the TTA. 

Status / Communications LED 
The red LED above the serial port will continually flash about 4 times per second while 
the TTA is properly booted and ready to accept commands from the PC.  This flashing 
will be interrupted and the LED will temporarily remain on or off while accepting and 
processing a command. 

Power Switch 
Turns the TTA on or off. 

Power LEDs 
The two green LEDs show the status of the power supply within the TTA.   
 
 
 



 
Figure 1:  Thermal Transient Anemometer 

 
 

    
Figure 2:  TTA Cable - TTA Side     Figure 3:  TTA Cable - Array Side 

 



GUI Overview 
 

Figure 4 shows the TTA Comm Interface for the Thermal Transient Anemometer 
with the various elements numbered for reference. 

1. Flow Rate pane – all information pertaining to the air speed through a cell will be 
displayed here 

2. Temperature Pane – all information pertaining to the temperature of a given cell 
will be displayed here. 

3. Cell – each cell has one block in each information pane.  The blocks will vary in 
color depending on the flow speed or temperature of the cell.  Clicking on a cell’s 
block will activate or deactivate it.  Inactive cells will be changed to grey.  The 
number of cell blocks shown will vary between 1 and 32 depending on the 
number of cells in the array calibration that has been loaded. 

4. Cell Data – the numerical representation of the air speed or temperature of a given 
cell. 

5. Cell Scale – shows the color for minimum and maximum flow / temperature.  
Clicking on the color bar will allow the user to change the colors and clicking  

6. External Voltage – shows the voltage ranging from -10V to 10V from the external 
input from a device such as a pressure transducer. 

7. Connect Button – opens a communication link to the TTA, this must be done 
prior to any commands or data being sent to or from the TTA. 

8. Save to File – when cycling the cells, indicates whether or not the data will be 
written to a file. 

9. Number of Cycles – selects the number of cycles to run.  A value of zero or any 
non-numerical value will loop until the user manually stops the TTA. 

10. Start Cycle – will measure each cell sequentially, starting over at the end of the 
array. 

11. Start After Trigger – will wait for the external trigger, then start taking flow and 
temperature data. 

12. Status Bar – gives information about the different aspects of the program when 
the mouse is hovered over them.  Also gives status information while the TTA is 
cycling. 

13. Progress bar – shows the relative progress of a set of cycles if the number of 
cycles box is set to a finite number 

14. Status Log – the 500 most recent status updates will be displayed here until it is 
cleared.  The status log can be shown or hidden through the View menu by 
choosing View GUI Log. 

15. Pause Log Button – stops the Status Log from being updated.  The most recent 
status update will still be shown in the Status Bar 

16. Clear Log Button – clears the Status Log. 



 
Figure 4:  TTA Comm Elements 



Menus 

File Menu 
• Connect to TTA – serves the same 

function as the Connect button on the 
main GUI window attempting to 
communicate with the TTA on the 
chosen serial port at a variety of baud 
rates. 

• Run Calibration – opens the calibration 
window.  This is done prior to the TTA 
shipping, and should never have to be 
accessed by the end user.  This option 
will be enabled once the TTA is 
connected. 

• Load TTA Setup – Loads values such 
as baud rate, sample number and sample frequency from a file. 

• Load TTA Calibration – loads a calibration for the TTA from a file.  This file will 
be included with the TTA and includes the information necessary to perform 
accurate resistance and voltage measurements. 

• Load Array Calibration – loads the calibration for a specific array of up to 32 cells 
from a file.  This file will be included with any TTA array and includes the 
information about the individual tungsten wires necessary to calculate overheats, 
temperatures and air flow. 

• Select Output File – allows the user to choose the file for data output. 
• Set File Number – allows the user to set up automatic numbering of sequential 

data output files.  This option will be enabled after a data output file is chosen. 
• Exit – closes the program. 

 

Settings Menu 
• Board Setup – opens the board setup window 

where baud rate, sample number, sample 
frequency, and overheat can be specified. 

• Cell Order – opens the cell order window 
where the user can define the order in which 
the cells will be run. 

• Com 1 – Com 4  - allow the selection of the 
serial port being used. 

 
 



View 
• Show Comm Log – shows the information flow 

between the TTA and the GUI.  Generally has no 
use beyond debugging purposes. 

• Show GUI Log – will expand the bottom of TTA 
Comm to show a real time log of the user 
activities. 

 
 

Flow (right click) 
• Cycle Cell – runs the chosen cell one 

time, without affecting any other cells. 

 
 

 

Temperature (right click) 
• Get Resistance – updates the number 

below the cell to show the electrical 
resistance of the wire in ohms.  Does 
not update the color swatch. 

• Get Temperature – updates the 
number below the cell to show the 
average temperature of the tungsten 
wire.  Does not update the color swatch 

• Cycle Cell – runs the chosen cell one time, without affecting any other cells. 
 
 

External Voltage (right click) 
• Cycle External Voltage – updates 

the External Voltage value. 
 
 



Connecting to the TTA 

Communications Port Selection 
TTA Comm does not automatically connect to the TTA upon launching.  Before any 

commands can be sent back and forth, the user must connect to the TTA.  TTA Comm 
uses one serial port, generally this will be Com 1 or Com 2, but ports 1 through 4 may be 
chosen from the settings menu as seen in Figure 5.  Com 1 will be chosen by default the 
first time the program is run, and if the correct port is not known, it is recommended to 
start with Com 1 and work from there. 
 

 
Figure 5:   Settings Menu 

 

Communications Attempts 
Once a Com port is chosen, clicking the Connect button will attempt to communicate 

with the TTA on the chosen port.  On power up, the TTA will initially be set to Comm 
settings of 19200, 8, n, 1.  It is recommended that the baud rate be left at 19200, but baud 
rates of 9600 and 38400 are also supported.  The baud rate can be set under the Board 
Setup item in the Settings menu.   

In the event that the baud rate is changed from the default and either TTA Comm or 
the TTA hardware is subsequently restarted, it is possible that the TTA and the PC will 
not be at the same baud rate.  To account for this chance, if TTA Comm is unable to 



communicate with the TTA at the currently set baud rate, it will then scan through the 
other allowable baudrates looking for one that does work. 

During the process of establishing communication with the TTA, the Connect button 
will be changed to Abort.  Clicking the Abort button will cause TTA Comm to cease it’s 
attempts to communicate with the TTA.  Upon successful connection, the Connect button 
will be change to Disconnect, and  the Start Cycle and Start After Trigger buttons seen at 
the at the bottom left of the GUI will be enabled. 



Setup 

TTA Settings Window 
The TTA setup window as seen in Figure 6 can be accessed through the Settings 

menu under Board Setup.  For general use, these settings will not require modification; 
however controls specific to the TTA control box can be set here if desired. 
 

1. Number of samples sets the number of A/D samples that are taken.  This value 
applies to the number of samples taken during the thermal decay, as well as the 
number of samples averaged when measuring external voltage or wire resistance.  
A setting of less than 300 will result in a warning window that the number of 
samples may be insufficient for reliable data.  Transfer of the sample data 
accounts for a large fraction of the time taken to cycle a cell, so it should be kept 
in mind that increasing the number of samples will result in a longer cycle time. 

2. Sampling frequency sets the frequency that the chosen number of samples is taken 
at.  If the sample frequency is set below 2000 samples per second, a warning 
window will be shown with a  warning that the frequency might be insufficient to 
capture the desired data from the thermal decay curve. 

 
Experimentally, the wires have been found to return to ambient temperature after 
approximately 150ms at zero flow.  The default number of samples and sampling 
frequency has been chosen to match this time.  In general the number of samples divided 
by the sampling frequency should be kept at 0.15 or slightly higher.  Other combinations 
will result in either insufficient or excessive data. 
 

3. The ratio of hot resistance to cold resistance can be set in the overheat box.  
Higher overheat may result in a more accurate reading, but risks ruining the wire.  
An overheat of 1.7 is recommended, and overheats of 2.0 or higher will be 
canceled. 

4. The Baud Rate setting determines how fast data is transferred between the TTA 
and PC.  Faster rates will shorten the overall cycle time, but increase the risk of 
corrupted data or communications errors. 

  

 
Figure 6:  TTA Settings 



TTA Cell Selection 
In the TTA Comm GUI, each rectangular block represents one cell of the array.  Each 

block is also a button.  Clicking the block will toggle the activity status of the cell.  If 
active, the cell will be shaded according to the last data measured for that cell.  Inactive 
cells will be shown in grey.  The status of a cell does not affect the cell order, it simply 
causes the cell to be skipped when it’s turn arrives.  Deactivating cells will shorten the 
cycle time for the remaining cells, allowing a subset of the array to be run faster than the 
full array.   Cells can be activated or deactivated without stopping the current cycle of the 
TTA. 

TTA Cell Order 
Upon loading, TTA Comm is set to run the cells sequentially starting with cell 1 and 

ending with the highest numbered cell in the array.  This will be done without any 
adjustment from the user at runtime.  In the case that this is not desirable, the TTA is 
capable of running cells out of the standard sequential order.   

The array cells can be reordered by choosing Cell Order from the Setting menu which 
will bring up the window seen in Figure 7.  Upon loading, the current cell order will be 
shown.  Active cells will have a white box, while inactive ones will be grey.  By 
changing the numbers shown below each cell, the cell order can be redefined.  Each cell 
must have a specified order, even if it is inactive at the time.  Re-ordering the cells is a 
matter of swapping orders.  When a number is changed for a cell it will automatically 
swap order with the cell currently using the number.  Attempting to enter a value outside 
the range of cells or an erroneous value will cause the cell to retain its current order. 

Using Figure 7 as an example, cells 1 through 8 would be run in reverse order.  Cells 
9 through 16 are deactivated and thus regardless of order, will not run.  If cells 9 through 
16 were later activated in the main GUI window, they would run in sequential order.  If 
any of cells 1 through 8 were later deactivated, they would be skipped, but the rest of the 
cells would continue to run in order.  If Cell 8 were changed to be 3rd in the running 
order, then Cell 6, which is currently 3rd would be changed to running 1st. 
 

  
Figure 7:  Cell Order 



Calibration 

Summary of Calibration Data 
Calibration is done prior to the TTA and accompanying array being shipped.  Due to 

the properties of the tungsten wires, the TTA should never need recalibration by the end 
user.  There are two independent calibration files one specific to the TTA control box and 
one specific to the set of TTA wire arrays being used.  The TTA specific calibration does 
not need to be changed to run different arrays, as the array specific calibration does not 
need to be changed to run the same array on different TTA control boxes.   

All files which hold calibration or settings data are saved in plain text format.  Upon 
loading, the file is checked to contain a proper header and the correct amount of data.  If 
the file appears to be invalid, the user will be warned and the calibration data will not be 
loaded. 

Loading Calibrations  

Default 
The set of calibrations which go with the original TTA control box and array will be 

stored in the install folder for TTA Comm as DefaultTTACal.txt and 
DefaultArrayCal.txt.  These files will automatically be loaded upon starting the TTA 
Comm software.  Alternative calibrations do not need to be loaded unless the TTA 
control box or TTA arrays are not those originally shipped with the software being used. 

Manual 
If the default files are not present, or contain undesired information, the user can load 

alternative calibrations through the GUI’s file menu.  This will be necessary if different 
arrays are to be used on the same TTA control box.  The calibrations are stored as plain  
text files, but the GUI will check to ensure that they contain a proper header and the 
correct amount of data, and will warn the user if the file was invalid. 

Running Calibrations  
Calibration is done prior to the TTA and accompanying array being shipped, but the 

calibration interface is built into TTA Comm.  The calibration interface can be accessed 
through the File menu by choosing Run Calibration.  This will open the window shown in 
Figure 8.  This portion of the manual is included for completeness, but should not be 
attempted by the user as the included calibration files could be overwritten. 

Running a calibration requires 
1. A minimum of two precise, high wattage (100W or greater) resistors, around 10 

Ohms.  Three or more different resistances are preferred for calibration of the cold 
resistance and overheat resistance measurements. 

2. At least two precise voltage sources, with three or more being preferred for 
calibration of the voltmeter. 

3. A controlled 27 degree Celsius environment for cold resistance measurement. 
4. At least two uniform, controlled temperatures in which a cell can be placed for the 

temperature calibration. 



5. At least three uniform, controlled flows in which a cell can be placed for the 
velocity calibration. 

 

 
Figure 8:  TTA Calibration Window 

 
Each of the panes numbered 1 through 3 controls a different calibration file.  The 

buttons at the bottom of each pane can be used to either write the current calibration data 
to a file, or read calibration data from an existing file.  Each part of the calibration relies 
on the previous part(s), and thus the previous part(s) must be completed prior to 
continuing with the next calibration. 

TTA General Setup 
The General Setup pane (1) has the same settings as the Board Setup window 

discussed earlier.  The only addition made in the calibration window is the ability to load 
and save a setup file.  The Use Current Setup button will accept the current values listed 
without any reading or writing from a file.  This may be useful if different settings are 
desired for calibration, but do not need to be saved for general use.  When choosing the 
values for General Setup, the same rules should be followed as in the Board Setup 
window of Figure 6. 

1. Higher baudrates will reduce cycle time, but make the TTA communications more 
error prone. 



2. An overheat of significantly less than 1.7 will decrease the accurace of flow 
measurements, while an overheat of significantly greater than 1.7 chances damage 
to the tungsten wire. 

3. A sample frequency less than 2 kHz may be too slow for accurate flow 
measurement. 

4. Fewer than 300 data points may be insufficient for accurate measurement, while 
greater than 300 generally will not increase the accuracy of flow measurement, 
but may improve voltage and resistance measurements. 

5. Frequency and number of points combinations for which points / frequency is 
much greater than 0.15 will cause a longer cycle time with no real benefit for flow 
measurement. 

TTA Specific Calibration 
The TTA specific calibration pane (2) contains the controls to setup and run 

calibrations pertaining to the internal operation of the TTA control box, but is not specific 
to any single cell array.  The TTA Specific Calibration requires that the values from the 
TTA General Setup be properly loaded or set prior to running.  A file containing the TTA 
Calibration will be included with the TTA and loaded automatically when TTAComm is 
started.  There are three sub-sections of the TTA calibration for voltage, resistance, and 
overheat measurement.  Loading a TTA calibration from a file overwrites the current data 
for all three sections.  Running any one of the three sub-calibrations overwrites only the 
data for that portion of the calibration allowing recalibration of any one part while 
retaining the rest of the calibration data. 

For each sub-calibration, there are two options that must be set prior to starting the 
calibration: the number of voltages or resistances and the number of samples at each 
value.  A minimum of two values are required since the calibration relies on a curve fit 
for the Analog to Digital conversion.  For the greatest accuracy, a large number of values 
ranging from -10 to 10 volts for voltage calibration, and 5 to 15 ohms for the resistance 
calibrations should be used.  The number of samples sets how many packets of data are 
requested from the TTA.  Each packet will contain in itself the numbers of data points set 
in the setup pane.  For the settings seen for resistance in Figure 8, 5 samples x 300 points 
per sample would be taken for each resistance value.  This means that the end 
measurement would be the average of 1500 A/D conversions.  

For all three sections of the calibration, it is important to use precise voltages or 
resistances.  For the Overheat Resistance calibration, the resistance will be measured 
based on the amount of current flowing through the resistor when approximately 30 volts 
is put across the wire.  The resistors used for calibration should be close to the hot 
resistances of a wire, from about 10 to 12 Ohms.  This means that the resistor must be 
able to dissipate at least 90 watts of power for a period of several seconds.  For the most 
accurate calibration, the resistor must be able to handle this much power without 
appreciable change in resistance due to heat. 

Once the values and sample numbers are entered, clicking the Calibrate button will 
start a series of prompts which will accept the current value from the user.  An example 
of this prompt for voltage calibration can be seen in Figure 9.  Before clicking OK, the 
appropriate voltage or resistance should be connected to the TTA.  In the case of 
resistance, the proper resistor must be connected to channel 1 as all other channels are 



ignored.  After clicking OK, the TTA will take the necessary data, during which time it is 
important that the voltage or resistance not be changed.  Once the next prompt comes up, 
it is safe to change the voltage or resistance connected.  The user will be prompted for the 
number of values previously entered in the calibration window.  Clicking Cancel on any 
prompt will discard the current calibration attempt and revert to the old data. 

 

 
Figure 9:  Prompt for Calibration Information 

TTA Array Calibration 
The TTA Array Calibration (3) houses calibration control specific to the array or 

arrays being used, which do not vary with the TTA control box.  It does however rely on 
the measurements from the TTA, and thus the TTA Specific Calibration must be 
completed or loaded from a valid calibration file prior to the TTA Array Calibration. 

The first part of the Array Calibration which must be set is the size of the array being 
used.  The software currently recognizes only a single rectangular array, and the GUI 
display will be adjusted based on the dimensions entered for the array calibration.  If 
multiple arrays are being used via splitting the cable, the user will have to enter the 
information as a single array and keep track of which cells belong to which arrays and/or 
ignore cells that are non-existant in the array.  Changing the dimensions of the array 
automatically invalidates all previously loaded or recorded array calibration information. 

When reading cold resistance, the only setting necessary is the number of cycles to 
run each cell.  The calibration routine will then cycle through the cells in order, checking 
the resistance.  For this portion of the calibration, the array must be placed in a controlled 
27 degree Celsius environment. 

The temperature and velocity calibrations have settings which control the number of 
sample values and number of cycles to run each cell, similar to the voltage and resistance 
routines.  As with the other calibrations, the more discrete values used for either flow or 
temperature, the better the calibration outcome will be.  For the velocity calibration only, 
a minimum of three different velocities are needed for a successful calibration.  Once 
started, the user will be prompted for each temperature or flow value.  Once a valid 
number is entered, the calibration routine will sequentially prompt the user to align each 
of the array cells with the flow or temperature.  If any of the prompts are canceled, the 
active portion of the calibration will fail and any calibration data loaded prior to starting 
the routine will be retained. 

Status Indicators 
The status indicators (4) give the user feedback on what aspects of the calibrations 

have been completed.  The yellow bars seen in Figure 8 will change color depending on 
the current status of the calibration.  The possible colors are red, yellow and green. 



• Red indicated that no valid data is loaded for the given calibration.  Either no 
calibration was loaded, or a calibration attempt failed after rewriting some or all 
of the previous data. 

• Yellow indicates that the calibration contains valid data.  This data could have 
come from one of three sources: a default calibration file that was loaded when 
the software was run, a calibration file that was loaded by the user either before or 
after opening the calibration windows, or from a successfully completed 
calibration that has been saved to a file by the user. 

• Green means that the indicated portion of the calibration has been successfully 
run, and the calibration data updated, but has not yet been saved to a file. 

Attempting to write a file with any of the calibration indicators being yellow or red 
will cause a prompt to warn that (red) faulty data, or (yellow) old data not from a fresh 
calibration, will be written to the file.  

Status Log 
The status log (5) can be expanded or collapsed similar to the log for the main 

window of TTAComm.  Unlike the main log, the last line is still shown when collapsed, 
serving as a real time status update to the user during a calibration. 



Data Acquisition 

Cycles 
A cycle is defined as a complete run through all active channels acquiring both 

temperature and flow data.  At the end of every cycle, the external voltage is sampled and 
displayed for the user.  As seen in Figure 10, the default is to cycle indefinitely until 
stopped by the user.  Entering 0 cycles, or any non-numeric character will cause the TTA 
to cycle continuously.  Entering any valid integer sets the number of cycles that will be 
run when the Start Cycle button is clicked or the Start After Trigger button is clicked and 
the trigger is received. 

 

 
Figure 10:  Data Acquisition Options 

Data Format 
There are two methods by which the user can retrieve data from the TTA, displayed 

in TTAComm or through an output file.   

GUI Display 
As the TTA cycles through the attached cells, the data for each cell is updated and 

will be displayed until the next time the cell is cycled.  Temperature and flow data will be 
displayed both as a number and through the coloration of the block corresponding to a 
specific cell.  This output method is constantly running even when file output is being 
used. 



File Output 
File output can be obtained by checking the Save to File check box prior to starting a 
cycle.  The file for output can be chosen through the File menu, or if not chosen, the user 
will be prompted when the TTA cycle is started.  After choosing the file, the user will be 
prompted with the window seen in Figure 11.  Once the file number and digits to be used 
are set, TTA Comm will automatically store the data from each sequential run in a new 
file and increment the file number.  If the number of runs exceeds that allowed by the 
chosen number of digits, TTA Comm will wrap back to 0 and overwrite the old files. 

 

 
Figure 11:  File Number 

 
The output will be a text file with data formatted as space delimited values.  Each line 

in the file represents one complete cycle through each cell in the array, as illustrated 
below. 
 

c1 t1,1 T1,1 V1,1 c2 t2,1 T2,1 V2,1 . . . cc tc,1 Tc,1 Vc,1 . . . c16 t16,1 T16,1 V16,1 E1  
  
c1 t1,2 T1,2 V1,2 c2 t2,2 T2,2 V2,2 . . . cc tc,2 Tc,2 Vc,2 . . . c16 t16,2 T16,2 V16,2 E2 

   . 

   .   . 
c1 t1,n T1,n V1,n c2 t2,n T2,n V2,n . . . cc tc,n Tc,n Vc,n . . . c16 t16,n T16,n V16,n En  

  
cx represents the number of the xth

 cell it will not vary with acquisition cycle. 
tx,y represents the time that the xth

 cell started heating in the yth cycle of data 
acquisition.  
Tx,y represents the temperature of the xth

 cell in the yth cycle of data acquisition. 
Vx,y represents the flow rate of the xth

 cell in the yth cycle of data acquisition. 
Ey represents the external voltage at the end of the yth cycle of data acquisition 

 

Sample Run 
Figure 12 shows TTA Comm after running a 16 cell array for three cycles with only 

the first two cells active.  The results of the most recent cycle can be seen in the 
coloration of the blocks and the numerical data below them.  Flow rates are in meters per 
second while Temperature is in degrees Celcius.  The sequence of events can be seen in 
the status log at the bottom of the program. 



 
Figure 12:  TTA Comm after three cycles 


